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 Εισαγωγή στο Στατιστικό πακέτο SPSS 14.0  

 Αρχικά 

 Ανοίγουµε το SPSS κάνοντας διπλό κλικ στο εικονίδιο  SPSS στην 

οθόνη ή πηγαίνοντας στο Start/Statistical Packages/SPSS 14.  

 

 

 
 

Όταν το πρόγραµµα “φορτώσει”, εµφανίζεται στη οθόνη ένα εισαγωγικό 

πλαίσιο διαλόγου µε διάφορες επιλογές, όπως:  

 

 

○ Run the tutorial Με την επιλογή αυτή µπορούµε να διαβάσουµε µία 

εισαγωγή στο SPSS  

 

○ Open an existing data source Με την επιλογή αυτή µπορούµε να 

ανοίξουµε ένα αποθηκευµένο αρχείο του SPSS. Στο κυλιόµενο παράθυρο 

εµφανίζονται τα εννέα πιο πρόσφατα χρησιµοποιηµένα αρχεία, ενώ µέσω της 

επιλογής More Files  Μπορούµε να εντοπίσουµε ένα αρχείο αποθηκευµένο σε 

οποιαδήποτε θέση στον υπολογιστή µας ή σε οποιοδήποτε µέσο 

αποθήκευσης. 
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Πατώντας Cancel µεταβαίνουµε σε ένα από τα οκτώ διαφορετικού τύπου 

παράθυρα του SPSS , το παράθυρο δεδοµένων το οποίο θα δούµε 

παρακάτω. 

  

 Παράθυρα του SPSS 

 

Data Editor window  
 

Στο παράθυρο αυτό εµφανίζονται τα περιεχόµενα ενός αρχείου. Εδώ  
Μπορούµε να δηµιουργήσουµε αρχεία δεδοµένων, ή να 
τροποποιήσουµε ένα ήδη υπάρχον.  
 

Viewer window  
 

Στο παράθυρο αυτό παρουσιάζονται τα στατιστικά αποτελέσµατα, οι 
πίνακες και τα γραφήµατα κάθε ανάλυσης. Ένα τέτοιο παράθυρο 
ανοίγει αυτόµατα κάθε φορά που εκτελείται µία διαδικασία  για να 
δηµιουργηθεί ένα αποτέλεσµα ενώ είναι δυνατή η επεξεργασία, 
αντιγραφή, επικόλληση και διαγραφή αποτελεσµάτων. 
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Draft Viewer window  
 

Στο παράθυρο αυτό µπορούν να παρουσιαστούν τα αποτελέσµατα 
εκτός από τα γραφήµατα ως απλό κείµενο.  
 

Pivot Table Editor window  
 

Τα αποτελέσµατα που παρουσιάζονται σε πίνακες µπορούν να 
τροποποιηθούν µε διάφορους τρόπους µέσω του Pivot Table Editor. 
Μπορεί να γίνει επεξεργασία του κειµένου, αντιµετάθεση γραµµών –
στηλών, να προστεθεί χρώµα, να δηµιουργηθούν πολυδιάστατοι 
πίνακες και να επιλέξουµε να εµφανίσουµε ή αποκρύψουµε 
αποτελέσµατα. 
  

Chart Editor window  
 

Μπορούµε να τροποποιήσουµε και να αποθηκεύσουµε γραφήµατα. 
Επίσης  Μπορούµε να επεξεργαστούµε το γράφηµα αλλάζοντας 
διάφορα χαρακτηριστικά του ακόµη και αυτό τον τύπο του γραφήµατος.  
 

Text Output Editor window  
 

Τα αποτελέσµατα κειµένου  είναι δυνατό να επεξεργαστούν και να γίνει 
αλλαγή στη µορφή της γραµµατοσειράς, τον τύπο κλπ. 
  

Syntax Editor window  
 

Οι εντολές καθώς και οι επιλογές που γίνονται σε ένα παράθυρο 
διαλόγου µιας διεργασίας µπορούν να επικολληθούν σε ένα Syntax 
Editor window και να εµφανιστούν µε τη µορφή εγγεγραµµένων 
εντολών. Οι εντολές αυτές µπορούν να τροποποιηθούν για να 
χρησιµοποιηθούν κάποιες επιπλέον δυνατότητες οι οποίες δεν 
εµφανίζονται στα παράθυρα επιλογών. Το παράθυρο αυτό µπορεί να 
αποθηκευθεί ώστε να χρησιµοποιηθεί σε µετέπειτα  αναλύσεις.  
 

Script Editor window  
 

Κάνοντας χρήση του Script Editor   Μπορούµε να δηµιουργήσουµε ή 
να τροποποιήσουµε  βασικές µικρές εφαρµογές οι  οποίες λειτουργούν 
σε συνεργασία µε άλλες εφαρµογές µε σκοπό την προσθήκη ειδικών 
λειτουργιών στο SPSS.  
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 Παράθυρο δεδοµένων του SPSS 

 

 
 

 

Status bar και Toolbar 

Το Status bar δηλώνει την τρέχουσα κατάσταση του επεξεργαστή του SPSS. 

Αν ο επεξεργαστής εκτελεί κάποια εντολή, εµφανίζει το όνοµα της εντολής και 

ένα µετρητή ο οποίος δείχνει τον αριθµό του στοιχείου που επεξεργάζεται από 

το σύνολο των δεδοµένων. Το Status bar επίσης παρέχει πληροφορίες όπως 

ποια εντολή χρησιµοποιείται, αν χρησιµοποιείται κάποιο «φίλτρο», αν είναι 

ενεργή  κάποια στάθµιση των δεδοµένων. 

  

 

Το toolbar βρίσκεται ακριβώς κάτω από το menu bar και εµφανίζει εικονίδια 

χρήσιµα για λειτουργίες που χρησιµοποιούνται συχνά.  

Για να µια σύντοµη περιγραφή του κάθε εικονιδίου αρκεί να µετακινήσουµε το 

δείκτη του ποντικιού πάνω σε κάθε εικονίδιο. 

Toolbar 

Status bar 

Data 
View 

Menu bar 

Variable 
View 
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Menu bar 

Το Menu bar περιέχει δέκα κυλιόµενα µενού, µέσω των οποίων  Μπορούµε 

να εκτελέσουµε µία εντολή ως εξής: 

 

1. Κάνουµε κλικ στο όνοµα του στοιχείου, όπως File.  

 

2. Κάνουµε κλικ στην εντολή που θέλουµε από το συγκεκριµένο µενού, 

όπως New ή πατάµε το γράµµα που συνδέεται µε αυτή την εντολή, N για το 

New). 

 

3 Αν η εντολή απαιτεί να δηλώσουµε κάποιες επιπλέον πληροφορίες, 

τότε το SPSS ανοίγει ένα πλαίσιο διαλόγου, διαφορετικά εκτελεί την εντολή 

άµεσα. 

Παρακάτω, στην παράγραφο  Περιγραφική Στατιστική, θα δούµε αναλυτικά 

τη χρήση εντολών για την Περιγραφική στατιστική µεταβλητών.  

 

Data και Variable view 

Στο παράθυρο δεδοµένων του SPSS εµφανίζονται δύο βασικά παράθυρα: 

 

 το Data view, όπου εισάγουµε, βλέπουµε και επεξεργαζόµαστε τα 

δεδοµένα.  

 

 το Variable view, όπου ορίζουµε πώς θα εµφανίζονται τα δεδοµένα (τα 

δεκαδικά ψηφία, τον τρόπο εµφάνισης ηµεροµηνίας, το εύρος των 

στηλών). Επίσης στο παράθυρο αυτό ορίζουµε τα ονόµατα των 

µεταβλητών, κάποια επεξηγηµατικές «ετικέτες» είτε για τις µεταβλητές 

είτε για τιµές δεδοµένων που θέλουµε να εµφανίζονται στα 

αποτελέσµατα και τον τρόπο µε τον οποίο θα εµφανίζονται οι  ελλιπείς 

τιµές.  
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Αρχικά το παράθυρο δεδοµένων είναι άδειο. Κάθε γραµµή των δεδοµένων θα 

περιέχει στοιχεία-δεδοµένα για ένα συγκεκριµένο άτοµο / αντικείµενο. Κάθε 

στήλη (VAR00001, VAR00002,...) αντιστοιχεί σε µία µεταβλητή. 

 

  

 Ενεργοποίηση παραθύρου 

 
Για να κάνουµε ένα παράθυρο ενεργό απλά κάνουµε κλικ µε το ποντίκι επάνω 

του στη βασική µπάρα των Windows. Μπορούµε επίσης να ενεργοποιήσουµε 

ένα παράθυρο χρησιµοποιώντας κυλιόµενο menu κάτω από την εντολή 

Window.  
 

 
 
 
Το σύµβολο √ µπροστά από το όνοµα δηλώνει ποιό παράθυρο είναι ενεργό. 

Κάνοντας κλικ σε οποιοδήποτε από τα παράθυρα µπορούµε να το 

ενεργοποιήσουµε. 

Η µετάβαση στο παράθυρο δεδοµένων από οποιοδήποτε άλλο παράθυρο 

µπορεί να γίνει και µε χρήση του εικονιδίου   . 
 
 

 Μεγιστοποίηση και ελαχιστοποίηση παραθύρου 

Με τα τρία αυτά κουµπιά   τα  οποία εµφανίζονται στην άκρη δεξιά 

από κάθε παράθυρο ελέγχουµε το µέγεθος του παραθύρου. Το πρώτο κουµπί 

ελαχιστοποιεί το παράθυρο, ώστε να µην είναι πλέον ορατό. Το παράθυρο 

µπορεί να γίνει πάλι ορατό µέσω της εντολής Windows και της  διαδικασίας 

που περιγράφηκε στην ενεργοποίηση παραθύρου . Το µεσαίο µας δίνει τη 

δυνατότητα εναλλαγής µεταξύ µεγιστοποίησης ενός παραθύρου και 

επαναφοράς του στο ενδιάµεσο µέγεθος. Το δεξί κουµπί κλείνει ένα 

παράθυρο. Αν το περιεχόµενο του παραθύρου δεν έχει αποθηκευθεί τότε 

αυτό χάνεται. 
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Το ίδιο σετ κουµπιών υπάρχει και στην κορυφή της οθόνης τα 

οποία αντιστοιχούν στις ίδιες λειτουργίες για το πρόγραµµα SPSS. 

 

 Εισαγωγή δεδοµένων 

Το SPSS δίνει τη δυνατότητα να εισάγουµε δεδοµένα µε αρκετούς τρόπους 

όπως:  

1. Πληκτρολογώντας δεδοµένα κατευθείαν στο data window 

2. Με αντιγραφή και επικόλληση 

3.  Άνοιγµα δεδοµένων από ένα αρχείο.  

Πληκτρολόγηση 

 

Για να εισάγουµε δεδοµένα σε ένα παράθυρο δεδοµένων του SPSS θα 

πρέπει να ανοίξουµε ένα κενό παράθυρο δεδοµένων επιλέγοντας File/New 

και από το παράθυρο διαλόγου  

 
 

και να επιλέξουµε SPSS  παράθυρο δεδοµένων. 

 

Τα δεδοµένα εισάγονται µε πληκτρολόγηση και πάτηµα του πλήκτρου 

Tab ή Enter. 

 

Παράδειγµα εισαγωγής δεδοµένων 
 

∆εκατέσσερις άνθρωποι ρωτήθηκαν πόσο κοστίζει το ακριβότερο τους 

ζευγάρι παπούτσια ενώ καταγράφηκε και το φύλο κάθε ατόµου καθώς και το 

πόσα ζευγάρια παπούτσια αγόρασαν την προηγούµενη χρονιά, όπως 

φαίνεται παρακάτω.  
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Εισάγουµε τα στοιχεία στο παράθυρο στοιχείων SPSS. Μπορούµε να 

κινηθούµε από κελί σε κελί µέσα στο παράθυρο στοιχείων µε τη 

χρησιµοποίηση του ποντικιού ή χρησιµοποιώντας τα βέλη στο πληκτρολόγιό 

µας. Παρατηρούµε τη µορφή των στοιχείων. Κάθε σειρά περιέχει όλες τις 

πληροφορίες για ένα άτοµο και κάθε στήλη αντιπροσωπεύει την πληροφορία 

(ή τη µεταβλητή) που έχει καταγραφεί. Αυτή είναι η συνηθισµένη µορφή που 

χρησιµοποιείται για όλους τους τύπους στατιστικών αναλύσεων. 

 

Νο Κόστος Φύλο Πλήθος Νο Κόστος Φύλο Πλήθος 

1 70 Γυναίκα 2 7 70 Γυναίκα 3 

2 80 Γυναίκα 4 8 150 Άνδρας 1 

3 90 Γυναίκα 2 9 45 Γυναίκα 4 

4 85 Άνδρας 5 10 70 Άνδρας 6 

5 30 Γυναίκα 2 11 110 Άνδρας 3 

6 65 Γυναίκα 4 12 85 Άνδρας 3 

7 70 Γυναίκα 3 13 85 Άνδρας 2 

8 150 Άνδρας 1 14 80 Άνδρας 2 
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Στη συνέχεια µεταβαίνουµε στο παράθυρο Variable view. Στη στήλη 

  

o Name δηλώνουµε τα ονόµατα των µεταβλητών.  

o Type δηλώνουµε τον τύπο των µεταβλητών. Η µεταβλητή filo ως 

µεταβλητή "κειµένου" δηλώνεται τύπου string. 

o Decimals δηλώνουµε τα δεκαδικά ψηφία των µεταβλητών. Μπορούµε 

είτε να πληκτρολογήσουµε τον αριθµό των δεκαδικών είτε να 

προσδιορίσουµε το πλήθος των δεκαδικών ψηφίων χρησιµοποιώντας 

τα βέλη   που εµφανίζονται όταν κάνουµε κλικ στο πλαίσιο 

αυτό.  
o Label πληκτρολογούµε µία λεκτική περιγραφή της µεταβλητής η οποία 

είναι χρήσιµη για την επεξήγηση της σε οποιοδήποτε χρήστη του 

αρχείου. 
o Values δίνουµε µία λεκτική περιγραφή των τιµών της µεταβλητής η 

οποία είναι χρήσιµη για την επεξήγηση της σε οποιοδήποτε χρήστη του 
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αρχείου αλλά και για την όσο γίνεται καλύτερη παρουσίαση των 

αποτελεσµάτων. Κάνοντας κλικ στο παράθυρο όπου αρχικά υπάρχει η 

λέξη None για όλες τις µεταβλητές εµφανίζεται ένα πλαίσιο διαλόγου. 
Πληκτρολογούµε στο πεδίο:  

 

  

 Value το γράµµα F όπως έχουµε εισάγει τα 

στοιχεία για τις γυναίκες 
 Label τη λεκτική επεξήγηση που θέλουµε και 

πατάµε Add  

Ακολουθούµε την ίδια διαδικασία για την τιµή M µε Label: Male  και οι 

επεξηγήσεις των τιµών F και M εµφανίζονται στο µεγάλο πλαίσιο 

 

 

 
Πατάµε OK για να  κατοχυρώσουµε την ενέργειά µας και το παράθυρο 

variable view έχει τη µορφή: 

 

 
 

ενώ η µορφή των δεδοµένων είναι η παρακάτω.  
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Φέρνοντας τον κέρσορα στο όνοµα της µεταβλητής «no»  βλέπουµε την 

ετικέτα της µεταβλητής, «αριθµός ζευγαριών» ενώ κάνοντας κλικ στο εικονίδιο 

 στο toolbar µπορούµε να εµφανίσουµε τις ετικέτες που έχουµε 

ορίσει για τις τιµές των µεταβλητών. 

Αντιγραφή-επικόλληση 

Το SPSS επιτρέπει: 

 

 Αντιγραφή δεδοµένων από ένα άλλο πρόγραµµα όπως 

Microsoft Excel , Minitab και επικόλληση στο παράθυρο 

δεδοµένων του SPSS .  

 Αντιγραφή δεδοµένων από έναν πίνακα του επεξεργαστή 

κειµένου Word και επικόλληση στο παράθυρο δεδοµένων του 

SPSS .   

 Αντιγραφή δεδοµένων από ένα παράθυρο δεδοµένων του SPSS 

και επικόλληση σε ένα άλλο παράθυρο δεδοµένων του SPSS.  

 

Προσοχή θα πρέπει να δοθεί στην περίπτωση επικόλλησης µεταβλητής 

χαρακτήρων. Στην περίπτωση αυτή θα πρέπει πρώτα να ορισθεί ο τύπος της 

συγκεκριµένης στήλης ως string και µετά να ακολουθήσει η επικόλληση. 
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Για να γίνει η αντιγραφή και επικόλληση αρκεί να ακολουθηθούν τα έξης 

βήµατα: 

1. Μαρκάρουµε  τα δεδοµένα.  
2. Επιλέγουµε Edit από το  menu bar και µετά Copy.  
3. Κάνουµε κλικ στο SPSS Data window  
4. Επιλέγουµε ένα από τα ακόλουθα:  

o Για να εισάγουµε δεδοµένα στο ίδιο παράθυρο δεδοµένων 
κάνουµε κλικ στο κελί από όπου θέλουµε να ξεκινά η 
επικόλληση , επιλέγουµε Edit και µετά Paste.  

o Για να αντικαταστήσουµε δεδοµένα στο τρέχον παράθυρο 
δεδοµένων µαρκάρουµε τα κελιά µε τα δεδοµένα που θέλουµε 
να αντικατασταθούν, επιλέγουµε Edit και µετά Paste .  

 

Άνοιγµα ∆εδοµένων από αρχείο 

Εισαγωγή αρχείου SPSS 
 

Μπορούµε να ανοίξουµε ένα υπάρχον αρχείο δεδοµένων του SPSS 

επιλέγοντας File>Open>Data και εντοπίζοντας µέσω ενός πλαισίου 

διαλόγου το φάκελο που είναι αποθηκευµένο το αρχείο.  
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Τα αρχεία  δεδοµένων του SPSS έχουν κατάληξη “.SAV”. 

 

Μπορούµε να ανοίξουµε διάφορους τύπους αρχείων µε την κατάλληλη 

επιλογή του τύπου αρχείου στο πλαίσιο των αρχείων καταλόγων (δείτε το 

πλαίσιο διαλόγου) 

 

Εισαγωγή φύλλου εργασίας δεδοµένων του Excel 
 

Μπορούµε να ανοίξουµε ένα φύλλο εργασίας του Excel ακολουθώντας τα 

παρακάτω βήµατα.  

Στο πλαίσιο διαλόγου Files of Type επιλέγουµε ως τύπο αρχείου που θέλουµε 

να ανοίξουµε Excel 
 

 
 

 

Στη συνέχεια προσδιορίζουµε τη θέση του αρχείου µέσω του πλαισίου 

διαλόγου Look in  και αφότου εντοπίσουµε τη θέση όπου βρίσκεται το αρχείο 

προχωρούµε κάνοντας πατώντας Open 

 

  

Παράδειγµα εισαγωγής αρχείου Excel 
 

Θεωρούµε ότι οι πληροφορίες που µας δόθηκαν στο προηγούµενο 

παράδειγµα σχετικά µε την αγορά παπουτσιών έχουν αποθηκευθεί σε ένα 

παράθυρο δεδοµένων Excel µε την ονοµασία SPSS.xls.  
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Κατά την  εισαγωγή του αρχείου αυτού µε χρήση της εντολής Open, 

εµφανίζεται το εξής παράθυρο διαλόγου 

 

 
 

Στο παράθυρο αυτό µας δίνεται η δυνατότητα της ανάγνωσης των ονοµάτων 

των µεταβλητών από την πρώτη γραµµή του φύλλου εργασίας του Excel 

καθώς και τα κελιά από τα οποία θα εισάγει δεδοµένα. 

Αν οι πληροφορίες στο παράθυρο αυτό συµφωνούν µε τα δεδοµένα µας στο 

Excel πατάµε OK και στο παράθυρο δεδοµένων εµφανίζονται τα δεδοµένα. 
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Eισαγωγή αρχείου ASCII (κείµενο) 
 

Μπορούµε να επιλέξουµε να ανοίξουµε ένα αρχείο χαρακτήρων ASCII 

(κείµενο) επιλέγοντας µία από τις παρακάτω δύο διαδικασίες: 

 

o File>Read Text Data  

 

o File > Open >Data και επιλογή τύπου αρχείου .txt, .dat 

 

Μετά την επιλογή Open και για τις δύο διαδικασίες εµφανίζεται ένας οδηγός 

εισαγωγής του αρχείου µε διαδοχικά παράθυρα επιλογών σε µία διαδικασία 

έξι βηµάτων. 

 

Παράδειγµα εισαγωγής αρχείου ASCII (κείµενο) 
 

 Περίπτωση Delimited variables- ∆ιαχωρισµένων µεταβλητών 

 

Θεωρούµε ότι οι πληροφορίες που µας δόθηκαν σε προηγούµενο παράδειγµα 

σχετικά µε την αγορά παπουτσιών έχουν αποθηκευθεί σε ένα αρχείο κειµένου 

µε την ονοµασία SPSS.txt, όπου οι µεταβλητές χωρίζονται από το σύµβολο 

της παραγράφου . 
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Με χρήση της επιλογής File> Read Text Data και τις κατάλληλες επιλογές 

ώστε να γίνει ορθά η ανάγνωση του αρχείου  

 

 

 

 

 

 

 Βήµα 2 δηλώνουµε ότι  

 η µορφή των δεδοµένων καθορίζεται ως 

Tab delimited (οι στήλες χωρίζονται από 

την παράγραφο) 

 Τα ονόµατα των στηλών βρίσκονται 

στην κορυφή του αρχείου  

 



Εισαγωγή στο Στατιστικό πακέτο SPSS 14.0                         17/IV                     Ευγενία Τσοµπανάκη 

 

 

 

 Βήµα 3 δηλώνουµε ότι  

 η γραµµή που θα γίνει η ανάγνωση των 

δεδοµένων είναι η δεύτερη  

και ότι 

 κάθε γραµµή αντιστοιχεί σε µία 

περίπτωση, έναν άνθρωπο για το 

παράδειγµά µας 

 

 

 

 

 Βήµα 4  

 Επιβεβαιώνουµε ότι τα στοιχεία 

χωρίζονται µε το σύµβολο της 

παραγράφου tab  

και 

 Βλέπουµε το πώς τα δεδοµένα θα 

εισαχθούν σε στήλες 
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 Βήµα 5 

Επιλέγοντας κάθε µεταβλητή στο παράθυρο 

Data preview ελέγχουµε το όνοµά της και τον 

τύπο µε τον οποίο θα εισαχθεί 

 

 

 

 

 Βήµα 6 

Έχουµε ολοκληρώσει τη διαδικασία εισαγωγής  

και πατώντας Finish τα δεδοµένα   

µεταφέρονται στο παράθυρο δεδοµένων του 

SPSS. 

 

 

Σε περίπτωση που οι µεταβλητές χωρίζονται µε κάποιο άλλο σύµβολο, για 

παράδειγµα µε το σύµβολο #, τότε θα έπρεπε στο βήµα 4 να κάνουµε την 

επιλογή  
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 Περίπτωση Fixed width variables- Σταθερού εύρους µεταβλητών 

 

Αν µεταξύ των µεταβλητών δεν υπήρχε κάποιο σύµβολο διαχωρισµού αλλά οι 

µεταβλητές έχουν δηµιουργηθεί µε τέτοιο τρόπο ώστε να διατηρείται σταθερό 

το εύρος καταγραφής τους , τότε η διαδικασία εισαγωγής για τα βήµατα  2 και 

4 αλλάζει: 

 

 
 

 

 Βήµα 2 δηλώνουµε ότι  

 η µορφή των δεδοµένων είναι Fixed width  

 

 Βήµα 4  

Στο Data preview µετακινούµαστε µε τις µπάρες κύλισης και επιβεβαιώνουµε 

ότι η ανάγνωση του αρχείου γίνεται ορθά. Τα κάθετα διανύσµατα δηλώνουν 

που θα γίνει ο χωρισµός των µεταβλητών. Μπορούµε να προσθέσουµε, να 
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αλλάξουµε τη θέση και να διαγράψουµε κάποιο από αυτά τα διανύσµατα 

σύροντας, κάνοντας κλικ στη θέση επιλογής ή µεταφέροντας το εκτός της 

περιοχής data preview, αντίστοιχα.  

 

 Έλεγχος στοιχείων / Αρχείου 

 

Ένας τρόπος να ελέγξουµε τα στοιχεία µας είναι µέσω της επιλογής Utilities> 

Variables ,όπου µας δίνονται αναλυτικές πληροφορίες για τις µεταβλητές. 

 

 
 

Επίσης χρήσιµη είναι η δυνατότητα συνοπτικής περιγραφής του αρχείου 

δεδοµένων, µέσω της επιλογής Utilities>Data Files Comments 
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 ∆ηµιουργία µεταβλητών 

 

 Μπορούµε να δηµιουργήσουµε ή να µετασχηµατίσουµε µεταβλητές στο 

SPSS µέσω της επιλογής Transform>Compute. 

 

Αν για τα δεδοµένα της αγοράς παπουτσιών υποθέσουµε ότι την επόµενη 

χρονιά υπάρχει µία αύξηση της τιµής των παπουτσιών κατά 10%, τότε στη 

µεταβλητή MulKostos εµφανίζονται οι υπολογισµένες µέσω της σχέσης 

MultKostos=Kostos+Kostos*10/100, οι νέες τιµές 

 

 
 

Στο µενού αυτό είναι δυνατό κάνοντας χρήση των συναρτήσεων που µας 

παρέχει το SPSS είναι δυνατός ο υπολογισµός και αποθήκευση διαφόρων 

συναρτήσεων µιας µεταβλητής. Για παράδειγµα θα µπορούσαµε κάνοντας 

χρήση της οµάδας συναρτήσεων Statistical να υπολογίσουµε κάποιο από τα 

διαθέσιµα στατιστικά µέτρα που µας παρέχονται 

 



Εισαγωγή στο Στατιστικό πακέτο SPSS 14.0                         22/IV                     Ευγενία Τσοµπανάκη 

  
 

 Χειρισµός µεταβλητών 

Αλλαγή τύπου 

 

 Μπορούµε να αλλάξουµε τους τύπους µεταβλητών µέσω στο παράθυρο 

variable view, στην επιλογή type. 

∆εν έχει νόηµα να προσπαθήσουµε να αλλάξουµε µία µεταβλητή η οποία 

περιέχει ονόµατα ανθρώπων σε αριθµητικές τιµές. Θα µπορούσαµε όµως να 

είχαµε µία µεταβλητή µε αριθµούς η οποία κατά λάθος εισήχθη ως κείµενο και 

µε τον κατάλληλο χειρισµό να την ορίσουµε ως αριθµητική. 

 

Κωδικοποίηση 

 

Ανάλυση σε οποιοδήποτε αρχείο δεδοµένων µπορεί να γίνει µόνο αν τα 

στοιχεία έχουν δηλωθεί στο αρχείο µε τη µορφή αριθµών (τιµές ή κωδικοί). 

Στο παράδειγµα µας δεν είναι δυνατόν να πάρουµε κάποια πληροφορία για τη 

µεταβλητή φύλο των αγοραστών αν αυτή απλά παραµείνει ως Filo µε τιµές F 

για τις γυναίκες και M για τους άνδρες. 

Για το λόγο αυτό θα πρέπει να δηµιουργήσουµε µία µεταβλητή , ας πούµε τη 

µεταβλητή Sex κάνοντας την ακόλουθη αντιστοίχηση 
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Τιµή Κωδικός 

F 0 

M 1 

 

Μέσω της εντολής Transform >Into Different Variables επιλέγουµε να 

δηµιουργήσουµε µία νέα µεταβλητή που θα περιέχει τις κωδικοποιηµένες 

τιµές της µεταβλητής sex. Αν επιλέγαµε οι κωδικοποιηµένες τιµές να 

αντικαταστήσουν τις αρχικές τιµές της µεταβλητής, τότε η επιλογή µας θα ήταν 

Into Same Variables. 

 

 

 
 

Στη συνέχεια εµφανίζεται ένα αρχικό παράθυρο επιλογών, το οποίο 

συµπληρώνουµε όπως φαίνεται παρακάτω 

 

 
 

Μεταφέρουµε τη µεταβλητή filo στο πεδίο και δηλώνουµε το όνοµα και 

πιθανών και την περιγραφή της νέας µεταβλητής στο πεδίο Output variable. 
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Για να κατοχυρώσουµε την επιλογή µας είναι απαραίτητο να πατήσουµε 

Change και τότε τη θέση του ερωτηµατικού που εµφανίζεται στο πεδίο για την 

Output variable παίρνει η λέξη sex. 

 

 
 

Στη συνέχεια προχωρούµε στην επιλογή  για να 

ορίσουµε την κωδικοποίηση. 

 

 
 

Στο πεδίο Value δίνουµε την τιµή F ενώ στο πεδίο New value την τιµή 0 και 

πατώντας Add µεταφέρεται ο µετασχηµατισµός αυτός στο πεδίο  

 

 
Με τον ίδιο τρόπο ορίζουµε και την κωδικοποιηµένη τιµή για την τιµή M και 

ολοκληρώνουµε τη διαδικασία κωδικοποίησης. 

Την επιλογή If που εµφανίζεται στο παράθυρο αυτό θα τη δούµε παρακάτω. 
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 Επιλογή δεδοµένων 

Είναι δυνατό κάποιες φορές να θέλουµε να προχωρήσουµε στην ανάλυση 

µόνο κάποιων από τα στοιχεία ενός συνόλου δεδοµένων τα οποία 

ικανοποιούν µία συγκεκριµένη συνθήκη. Για παράδειγµα θα θέλαµε ανάλυση 

µόνο για τις γυναίκες φοιτήτριες ή για τους φοιτητές οι οποίοι ανήκουν σε µία 

συγκεκριµένη ηλικιακή ή οικονοµική τάξη. 

Για να γίνει αυτό αφού επιλέγουµε την εντολή Data>Select cases 

Στο παράθυρο διαλόγου που ανοίγει προσδιορίζουµε στην επιλογή If 

Condition is satisfied τις τιµές στις οποίες θέλουµε να εστιάσουµε την 

προσοχή µας.  

Στο δικό µας παράδειγµα έστω ότι θέλουµε να συλλέξουµε πληροφορίες µόνο 

για τα παπούτσια τα οποία κοστίζουν λιγότερο από 100euro. Για το λόγο αυτό 

ορίζουµε ως συνθήκη Kostos <=100. 

 

 
  

Με αυτή τη διαδικασία δηµιουργούµε µία νέα µεταβλητή, µεταβλητή «φίλτρο» 

στο αρχείο των δεδοµένων σύµφωνα µε τη συνθήκη που θέσαµε. Στο 

αριστερό πλαίσιο των δεδοµένων οι περιπτώσεις που δεν έχουν επιλεγεί 

εµφανίζονται µε µία γραµµή διαγραφής. 
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Για να έχουµε στη διάθεσή µας για ανάλυση το σύνολο των δεδοµένων θα 

πρέπει να ακολουθήσουµε την ίδια διαδικασία όπως για την επιλογή ενός 

υποσυνόλου και στο παράθυρο διαλόγου να επιλέξουµε All cases 

 

 
 

 Στατιστική Ανάλυση 

Αρχικά θα ασχοληθούµε µε βασική στατιστική ανάλυση των στοιχείων. Η 

έµφαση δίνεται στη χρήση στου στατιστικού πακέτου για την απόκτηση των 

αποτελεσµάτων και όχι στην ερµηνεία των εννοιών.  

Για να προβούµε σε βασική στατιστική ανάλυση, κάνουµε κλικ στη λέξη 

Analyze στο µενού εντολών.  
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Περιγραφική στατιστική 

Στο κυλιόµενο µενού επιλέγουµε  Descriptive Statistics   

 

 
 

Με την επιλογή Descriptives ανοίγει το παρακάτω παράθυρο  

 

 
 

 

 

Μεταφέρουµε τη µεταβλητή/ες που επιθυµούµε να αναλύσουµε στο δεξί 

ορθογώνιο πλαίσιο των µεταβλητών. Ένας τρόπος να γίνει αυτό είναι να 

κάνουµε δύο φορές κλικ στη µεταβλητή kostos στο αριστερό πλαίσιο. 

∆ιαφορετικά αφού µαρκάρουµε τη µεταβλητή που επιθυµούµε να αναλύσουµε 

στο αριστερό πλαίσιο πατάµε το βελάκι και τη µεταφέρουµε στο δεξί πλαίσιο 

των µεταβλητών προς ανάλυση.  

Εάν αυτό γίνει, η µεταβλητή kostos θα εµφανίζεται τώρα στο ορθογώνιο 

πλαίσιο των µεταβλητών.   

Παράθυρο εµφάνισης 

όλων των µεταβλητών 

του αρχείου 

Παράθυρο 

επιλεγµένων για 

ανάλυση µεταβλητών 

Επιλογή για να µας 

δοθεί η δυνατότητα 

εµφάνισης διαφόρων 

περιγραφικών µέτρων 

 

 

Βέλος µετακίνησης 

µεταβλητών 
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Στο παράθυρο αυτό επιλογών δίνεται η δυνατότητα να ζητήσουµε και άλλα 

περιγραφικά µέτρα εκτός από αυτά που εµφανίζονται µε ένα √ στο παρακάτω 

παράθυρο 

 

 
 

Επιλέγοντας κάποιες από τις διαθέσιµες επιλογές και πατώντας OK, στο 

Output Window, είναι τα στατιστικά αποτελέσµατα.  

 

 
 Descriptive Statistics 
 

  N Range Minimum Maximum Sum Mean 
Std. 

Deviation Variance 

  Statistic Statistic Statistic Statistic Statistic Statistic Std. Error Statistic Statistic 
Κόστος ακριβότερου 
ζευγαριού 14 120 30 150 1115 79,64 7,495 28,043 786,401

Valid N (listwise) 14            
 

 

Αν θέλαµε να µας δοθούν τα περιγραφικά µέτρα αναλυτικά για τις δύο τιµές 

της µεταβλητής sex, τότε από την επιλογή Descriptives θα επιλέγαµε Explore.  

 



Εισαγωγή στο Στατιστικό πακέτο SPSS 14.0                         29/IV                     Ευγενία Τσοµπανάκη 

 
 
και τότε θα είχαµε αναλυτικά τα αποτελέσµατα ως εξής: 
 
 

Descriptives

64,29 7,748
45,33

83,24

64,76
70,00

420,238
20,500

30
90
60
35

-,710 ,794
-,061 1,587
95,00 10,235
69,96

120,04

93,33
85,00

733,333
27,080

70
150

80
30

1,736 ,794
2,993 1,587

Mean
Lower Bound
Upper Bound

95% Confidence
Interval for Mean

5% Trimmed Mean
Median
Variance
Std. Deviation
Minimum
Maximum
Range
Interquartile Range
Skewness
Kurtosis
Mean

Lower Bound
Upper Bound

95% Confidence
Interval for Mean

5% Trimmed Mean
Median
Variance
Std. Deviation
Minimum
Maximum
Range
Interquartile Range
Skewness
Kurtosis

Sex of students
Female

Male

Κόστος ακριβότερου
ζευγαριού

Statistic Std. Error
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Παρατηρούµε ότι στο παράθυρο αυτό µας δίνεται η δυνατότητα επιλογής και 

γραφηµάτων αλλά µε τη δηµιουργία γραφηµάτων θα ασχοληθούµε 

παρακάτω. 

Τα περιγραφικά µέτρα µεταβλητών είναι δυνατό να µας δοθούν και µέσω της 

επιλογής υπολογισµού συχνοτήτων, όπως θα δούµε αµέσως παρακάτω. 

Κατανοµή συχνοτήτων 

Στο κυλιόµενο µενού Descriptive Statistics, επιλέγουµε Frequencies  

  

 
 

και µε την επιλογή  µας δίνεται ο παρακάτω πίνακας 

 

Sex of students

7 50,0 50,0 50,0
7 50,0 50,0 100,0

14 100,0 100,0

Female
Male
Total

Valid
Frequency Percent Valid Percent

Cumulative
Percent

 
 
Μέσω αυτής της εντολής το SPSS µας δίνει για κάθε τιµή της µεταβλητής, τα 

ονόµατα των οποίων βρίσκονται στην 1η στήλη, τη συχνότητα (Frequency) , 

τη σχετική συχνότητα ως ποσοστό (Percent), το ποσοστό των περιπτώσεων 

για τα οποία έχουµε τιµή στο αρχείο δεδοµένων δηλαδή δεν είναι ελλείπεις 

(Valid Percent) και την αθροιστική σχετική συχνότητα (Cumulative Percent) 

οποιουδήποτε τύπου µεταβλητών. Σε περίπτωση που δεν υπάρχουν 
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ελλείπεις τιµές , τότε η στήλη των σχετικών συχνοτήτων ταυτίζεται µε τη στήλη 

(Percent) και (Valid Percent) ταυτίζονται. 

Θα πρέπει βέβαια να τονίσουµε ότι η χρήση αυτής της επιλογής θα πρέπει να 

γίνεται για διακριτές µεταβλητές ή µεταβλητές µε περιορισµένο αριθµό 

κατηγοριών. Για συνεχείς µεταβλητές αφού αφαιρέσουµε το √ από την 

επιλογή Display Frequency tables, µπορούµε να ζητήσουµε περιγραφικά 

µέτρα της µεταβλητής µέσω της επιλογής Statistics  

 

 
 

 

 Γραφική παράσταση δεδοµένων 

Το SPSS µας δίνει τη δυνατότητα δηµιουργίας διάφορων τύπων γραφηµάτων 

είτε άµεσα µέσω της εντολής Graph και την κατάλληλη επιλογή από το 

κυλιόµενο παράθυρο ή ως επιλογή µέσω των εντολών ανάλυσης και τα 

παράθυρα διαλόγου. 

 

 Bar graph 

 

Για να δηµιουργήσουµε ένα ραβδόγραµµα επιλέγουµε Graph < Bar και στο 

παράθυρο που ακολουθεί κάνουµε τις επιλογές 
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Στη συνέχει εµφανίζεται ένα ακόµη παράθυρο επιλογών 

 

 
 

όπου έχουµε τη δυνατότητα επιλογής ραβδογράµµατος  
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o συχνοτήτων –N of cases  

o σχετικών συχνοτήτων % of cases 

o αθροιστικών συχνοτήτων Cum. N 

o αθροιστικών σχετικών συχνοτήτων Cum % 

 

Για το παράδειγµά µας θα θέλαµε να δηµιουργήσουµε ένα ραβδόγραµµα της 

µεταβλητής sex. Συµπληρώνουµε τα πεδία όπως φαίνεται στο παράθυρο και 

δηµιουργείται το παρακάτω γράφηµα: 

 

 
 

 Frequency polygon 

 

Για να δηµιουργήσουµε ένα πολύγωνο συχνοτήτων επιλέγουµε Graph < Line 

και στο παράθυρο που ακολουθεί κάνουµε τις επιλογές 
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Στη συνέχει εµφανίζεται ένα ακόµη παράθυρο επιλογών µε τις ίδιες επιλογές 

όπως και στο ραβδόγραµµα µε  
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Για το παράδειγµά µας θα θέλαµε να δηµιουργήσουµε ένα πολύγωνο 

συχνοτήτων της µεταβλητής no. Συµπληρώνουµε τα πεδία όπως φαίνεται στο 

παράθυρο και δηµιουργείται το παρακάτω γράφηµα: 

 

 

 Pie chart 

Για να δηµιουργήσουµε ένα κυκλικό γράφηµα, επιλέγουµε Graph < Pie και στο 

παράθυρο που ακολουθεί κάνουµε τις επιλογές 

 

 
 

Στη συνέχει εµφανίζεται ένα ακόµη παράθυρο επιλογών 
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Συµπληρώνουµε τα πεδία όπως φαίνεται στο παράθυρο και δηµιουργείται το 

παρακάτω γράφηµα: 
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 Histogram 

 

Για να δηµιουργήσουµε ένα ιστόγραµµα, επιλέγουµε Graph < Histogram και 

εµφανίζεται το ακόλουθο παράθυρο  

 

 
 

Συµπληρώνουµε τα πεδία όπως φαίνεται στο παράθυρο και δηµιουργείται το 

παρακάτω γράφηµα:  
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 Stem and Leaf 

 

Το SPSS δεν µας δίνει τη δυνατότητα παραγωγής διαγράµµατος µίσχου –

φύλλου από το βασικό µενού των Graphs αλλά µέσω της επιλογής  Analyze> 

Descriptive Statistics> Explore  όπου στην επιλογή Charts  µας δίνεται η 

δυνατότητα επιλογής του συγκεκριµένου γραφήµατος µέσω του παραθύρου 

 
 

 

Συµπληρώνουµε τα πεδία όπως φαίνεται στο παράθυρο και δηµιουργείται το 

παρακάτω γράφηµα στο Output του SPSS 

 
Κόστος ακριβότερου ζευγαριού Stem-and-Leaf Plot 
 
 Frequency    Stem &  Leaf 
 
     2,00 Extremes    (=<45) 
     1,00        6 .  5 
     3,00        7 .  000 
     5,00        8 .  00555 
     1,00        9 .  0 
     2,00 Extremes    (>=110) 
 
 Stem width:        10 
 Each leaf:       1 case(s) 
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 Επεξεργασία γραφηµάτων 

 

Μετά την παραγωγή γραφήµατος και την εµφάνισή του στην οθόνη µας, 

πιθανόν να θέλουµε να παρέµβουµε κάνοντας κάποιες τροποποιήσεις. Για να 

γίνει αυτό κάνουµε διπλό κλικ στο γράφηµα και ενεργοποιείται ο Chart Editor 

µέσω του οποίου µπορούµε να παρέµβουµε στο γράφηµα.  
 

 Χρήση Εντολών 

 

Οι ίδιες πληροφορίες µπορούν να αποκτηθούν και µε τη χρήση εντολών. Για 

το σκοπό αυτό θα πρέπει απλά στο παράθυρο επιλογής κάποιας εντολής 

πριν να πατήσουµε OK να πατήσουµε Paste. Οι εντολές καθώς και οι 

επιλογές που γίνονται σε ένα παράθυρο διαλόγου µιας διεργασίας 

επικολλούνται Syntax Editor window και να εµφανιστούν µε τη µορφή 

εγγεγραµµένων εντολών. Η εκτέλεση της εντολής µπορεί να γίνει µε επιλογή 

και πάτηµα του κουµπιού  στο toolbar του Syntax Editor window. 

Με τον τρόπο αυτό για κάθε ενέργεια που πραγµατοποιούµε στο SPSS µέσω 

των παραθύρων εµφανίζεται η σύνταξη της αντίστοιχης εντολής στο SPSS. 

Έτσι είναι δυνατή η εκµάθηση βασικών εντολών.  

Για παράδειγµα για να µας δοθούν περιγραφικά µέτρα και το ιστόγραµµα για 

τη µεταβλητή “Κόστος” η σύνταξη των εντολών/υποεντολών είναι: 
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 Ρυθµίσεις 

 

Υπάρχει η δυνατότητα ρυθµίσεων στο SPSS µέσω της επιλογής, Edit> 

Options και τη ρύθµιση των επιλογών µέσω των δέκα διαφορετικών καρτελών 

που εµφανίζονται, ανάλογα µε το θέµα που αφορά η ρύθµιση που επιθυµούµε 

να κάνουµε. 

 

 
 

  

 Βοήθεια 

 

Θα πρέπει να τονιστεί ιδιαίτερα ότι είναι πολύ σηµαντική η χρήση της 

βοήθειας Help κάθε προγράµµατος που χρησιµοποιούµε. Το SPSS παρέχει 

σηµαντική βοήθεια µέσω της εντολής Help αλλά και σε κάθε επιλεγόµενο 

παράθυρο. Ας δούµε στο συγκεκριµένο µενού επιλογών τη βοήθεια που θα 

µπορούσαµε να έχουµε για παράδειγµα στη χρήση της εντολής Calc µέσα 

από το παράθυρο επιλογής της εντολής: 



Εισαγωγή στο Στατιστικό πακέτο SPSS 14.0                         41/IV                     Ευγενία Τσοµπανάκη 

 

 

 

 

Κάνοντας κλικ 

στο εικονίδιο  

Μας δίνονται 

επιπλέον 

πληροφορίες  

  

 

 

 

 

 

 

Κάνοντας κλικ 

στη λέξη Show 

ακολουθεί µία 

πλοήγηση στο 

συγκεκριµένο 

θέµα  
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Στο παράθυρο 

αυτό µε χρήση 

των κουµπιών 

 
µπορούµε να 

µετακινηθούµε 

προς τα εµπρός 

ή πίσω στο 

επεξηγηµατικό 

κείµενο 

 

 

Επίσης θα πρέπει να σηµειωθεί ότι το SPSS για κάθε  εικονίδιο που 

εµφανίζεται σε ένα πλαίσιο διαλόγου είναι δυνατό να µας εµφανίσει µία 

επεξήγηση κάνοντας δεξί κλικ στο εικονίδιο. Αν για παράδειγµα στο πλαίσιο 

διαλόγου της εντολής Calc κάνουµε δεξί κλικ στο εικονίδιο  If εµφανίζεται η 

εξής πληροφορία 

 

   
 

 Αποθήκευση 

 

Για να αποθηκεύσουµε τη δουλειά µας στο SPSS επιλέγουµε File Save As και 

µε τον τρόπο αυτό είναι δυνατό να αποθηκεύσουµε   

 

o Παράθυρο δεδοµένων µε την κατάληξη .sav 

o Παράθυρο αποτελεσµάτων µε την κατάληξη .spo 

o Παράθυρο σύνταξης εντολών µε την κατάληξη .sps 
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Υπάρχει η δυνατότητα να αποθηκεύσουµε το αρχείο των δεδοµένων µας και 

ως άλλου τύπου αρχείο µε την κατάλληλη επιλογή του τύπου αρχείου στο 

πλαίσιο των αρχείων καταλόγων (δείτε το πλαίσιο διαλόγου), ώστε να είναι 

δυνατή η άµεση επεξεργασία του µε άλλα προγράµµατα 

 

 
 

Επίσης είναι δυνατό να επιλέξουµε κάποιες από τις µεταβλητές  του αρχείου 

να αποθηκευθούν στο ήδη υπάρχον ή σε ένα νέο αρχείο, µέσω της επιλογής 

Variables. Κάθε µεταβλητή που εµφανίζεται µε ένα  στο όνοµά της θα 

διατηρηθεί και θα σωθεί στο αρχείο ενώ οι υπόλοιπες διαγράφονται. 
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 Εκτύπωση  

 

 Μπορούµε να τυπώσουµε οποιοδήποτε παράθυρο µε τη µετάβαση στις 

επιλογές αρχείων File και την επιλογή της Print. Αυτό ισχύει για Microsoft 

Word SPSS, και για οποιοδήποτε πρόγραµµα λογισµικού εάν 

χρησιµοποιούµε το λειτουργικό σύστηµα παραθύρων της Microsoft.  
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 Εφαρµογή µε χρήση του Στατιστικού πακέτου 
SPSS 
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Περιγραφή ∆εδοµένων

Σε µία έρευνα µετρήθηκε η ποσότητα
γλυκόζης (mg%) στο αίµα εκατό
ατόµων για τη διερεύνηση της ύπαρξης
διαβήτη ενώ καταγράφηκε και το φύλο
του ασθενούς
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∆εδοµένα
Α/Α Γλυκόζη (mg%) Φύλο Α/Α Γλυκόζη (mg%) Φύλο Α/Α Γλυκόζη (mg%) Φύλο Α/Α Γλυκόζη (mg%) Φύλο

1 70 Γ 26 101 Α 51 85 Γ 76 102 Α
2 86 Γ 27 103 Γ 52 90 Α 77 106 Α
3 93 Γ 28 106 Α 53 94 Γ 78 107 Α
4 95 Α 29 110 Γ 54 96 Α 79 111 Γ
5 97 Α 30 116 Α 55 98 Α 80 121 Γ
6 101 Γ 31 83 Α 56 101 Γ 81 86 Γ
7 103 Γ 32 88 Γ 57 104 Α 82 92 Α
8 106 Γ 33 93 Α 58 106 Γ 83 94 Α
9 107 Γ 34 96 Γ 59 111 Α 84 97 Α

10 112 Α 35 98 Α 60 116 Γ 85 100 Α
11 79 Γ 36 101 Γ 61 85 Α 86 102 Γ
12 87 Γ 37 104 Γ 62 91 Γ 87 106 Γ
13 93 Α 38 106 Α 63 94 Α 88 107 Γ
14 95 Α 39 111 Α 64 96 Γ 89 112 Α
15 97 Α 40 116 Α 65 98 Γ 90 121 Α
16 101 Α 41 85 Α 66 102 Α 91 86 Γ
17 103 Γ 42 89 Γ 67 105 Α 92 92 Α
18 106 Γ 43 94 Γ 68 106 Γ 93 94 Α
19 108 Γ 44 96 Γ 69 111 Γ 94 97 Γ
20 115 Α 45 98 Α 70 119 Α 95 100 Γ
21 80 Γ 46 101 Α 71 85 Γ 96 103 Α
22 87 Α 47 104 Α 72 91 Α 97 106 Α
23 93 Γ 48 106 Α 73 94 Γ 98 107 Α
24 96 Γ 49 111 Γ 74 97 Γ 99 112 Γ
25 98 Γ 50 116 Γ 75 98 Γ 100 126 Γ
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Οργάνωση ∆εδοµένων

• Πεδίο Μεταβλητών – Variable View
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1..Οργάνωση ∆εδοµένων
Ονόµατα Μεταβλητών

• Ονόµατα µεταβλητών
Πληκτρολογούµε στo
πεδίο Name
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2.Οργάνωση ∆εδοµένων
Τύπος Μεταβλητών

• ∆ιαµόρφωση
µεταβλητών
– ∆ιαµορφώνουµε τις

µεταβλητές
καθορίζοντας αν είναι
απαραίτητο τον Τύπο
των µεταβλητών

Για τα τέσσερα πρώτα είδη µεταβλητών, “Numeric, Comma, Dot, 
Scientific Notation στο µενού καθορισµού του συγκεκριµένου τύπου
µπορούµε να ορίσουµε και τον αριθµό των δεκαδικών ψηφίων “Decimal 
Places”
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3.Οργάνωση ∆εδοµένων
Missing values

• ∆ιαµόρφωση
µεταβλητών
Καθορίζουµε την
τιµή / τιµές που θα
παριστάνουν πιθανές
ελλιπείς
παρατηρήσεις
(missing values) 
στο αρχείο των
δεδοµένων µας
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4. Οργάνωση ∆εδοµένων
Περιγραφή Μεταβλητών ~ Label

• Περιγραφή
µεταβλητών
Στο πεδίο Label 
µπορούµε να
πληκτρολογήσουµε
µία συνοπτική
περιγραφή της κάθε
µεταβλητής του
αρχείου
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5.Οργάνωση ∆εδοµένων
Περιγραφή Τιµών Μεταβλητών ~ Values

• Περιγραφή τιµών
µεταβλητών
Στο πεδίο Values 
µπορούµε να
δηλώσουµε µία
συνοπτική
περιγραφή κάθε
τιµής µιας
µεταβλητής του
αρχείου

Η χρήση του πεδίου values είναι απαραίτητη στις ποιοτικές µεταβλητές
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6.Οργάνωση ∆εδοµένων
Κωδικοποίηση µεταβλητών

• Κωδικοποίηση
µεταβλητών

Η κωδικοποίηση θα πρέπει να γίνεται σε µία νέα µεταβλητή. 

Αν η τροποποίηση γίνει στην ίδια βασική µεταβλητή του αρχείου µας
στην οποία βασίζουµε την κωδικοποίηση, η µετατροπή δεν είναι
αναστρέψιµη
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Κωδικοποίηση Μεταβλητής Sex
• Female:0
• Male:1

Πατάµε Change για να
ορίσουµε το όνοµα της νέας
µεταβλητής

Πληκτρολογούµε της τιµές
της “παλιάς” µεταβλητής

Πληκτρολογούµε της τιµές
της “νέας” µεταβλητής

Πατάµε Add για να ορίσουµε
τις τιµές της νέας
µεταβλητής
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Οµαδοποίηση Μεταβλητής Glucose

• ≤77   :0  “No diabetes”
• 77-112  :1  “Borderline”
• >112   :2  “Diabetes”

Τα διαστήµατα είναι κλειστά άνω
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∆ηµιουργία Νέας Μεταβλητής Glucose_10
• ∆ηµιουργία νέας

µεταβλητή

Αν τα όρια για το χαρακτηρισµό της κατάστασης ενός ασθενή µας δίνονται ως εξής:
≤7,7  :0  “No diabetes”

7,7-11,2  :1  “Borderline”
>11,2   : 2  “Diabetes”

είναι απαραίτητη η δηµιουργία µίας νέας µεταβλητής µε τιµές γλυκόζης το 1/10 των
τιµών που έχουν καταγραφεί για τους ασθενείς
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Αρχείο ∆εδοµένων

• Το αρχείο δεδοµένων για τους
πρώτους 10 ασθενείς
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Μεταβλητές

• Ποσοτικές -Συνεχείς
Ποσότητα γλυκόζης ~ GlucogeGlucoge

• Ποιοτικά-Κατηγορικά
Φύλο ~SexSex

Χαρακτηρισµός ατόµου~ StatusStatus
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1.1 Ανάλυση ∆εδοµένων “Glucose”
• Μετρήσιµη Μεταβλητή

Κατανοµή Συχνοτήτων ∆ΕΝ έχει νόηµα γι’ αυτό το λόγο οµαδοποιούµε τη
µεταβλητή αυτή στη µεταβλητή status
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1.2 Ανάλυση ∆εδοµένων “Glucose”
• Μετρήσιµη Μεταβλητή

Περιγραφικά Μέτρα
Analyze>Descriptive Statistics->Descriptives

Οι εργασίες που κάνουµε κάνοντας χρήση των µενού µπορούν να γίνουν
και µε χρήση εντολών στο Syntax του SPSS. 

Για να είναι δυνατή η εµφάνιση των εντολών του SPSS σε κάθε µενού
εργασίας αρκεί να επιλέξουµε Paste, οπότε και δηµιουργείται ένα αρχείο
παρουσίασης των εντολών (Syntax) για τη συγκεκριµένη εργασία
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1.3 Ανάλυση ∆εδοµένων “Glucose”

• Περιγραφικά Μέτρα
Αποτελέσµατα στο Output του SPSS

Descriptive Statistics

100 56 70 126 10000 100,00 1,014 10,137 102,768 -,052 ,241 ,131 ,478
100

glucose in blood mg%
Valid N (listwise)

Statistic Statistic Statistic Statistic Statistic Statistic Std. Error Statistic Statistic Statistic Std. Error Statistic Std. Error
N Range Minimum Maximum Sum Mean Std. Variance Skewness Kurtosis
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1.4 Ανάλυση ∆εδοµένων “Glucose”
• Περιγραφικά Μέτρα

Μέσω της επιλογής αυτής µπορούµε µεταξύ άλλων µέτρων να
υπολογίσουµε το συντελεστή ασυµµετρίας, τον αρµονικό, γεωµετρικό
µέσο κλπ. 
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1.5 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Dot-Plot ~∆ιάγραµµα Σηµείων

Στο γράφηµα αυτό η θέση κάθε δεδοµένου σε έναν αριθµηµένο άξονα
καθορίζεται µε µία κουκκίδα. Όπου οι τιµές συµπίπτουν οι κουκκίδες
τοποθετούνται η µία πάνω από την άλλη.
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1.6 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Stem-and-Leaf ∆ιάγραµµα Μίσχου-Φύλλου
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1.7 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

glucose in blood mg% Stem-and-Leaf Plot
Frequency    Stem &  Leaf

1,00 Extremes    (=<70) Η µικρότερη τιµή γλυκόζης είναι 70
1,00        7 .  9
2,00        8 .  03
11,00       8 .  55556667789

15,00       9 .  011223333444444 Μεγαλύτερη συγκέντρωση τιµών
18,00       9 .  556666677777888888 µεταξύ 90 και 108
18,00      10 .  001111112223333444
16,00      10 .  5666666666677778
9,00       11 .  011111222
6,00       11 .  566669
2,00       12 .  11

1,00 Extremes    (>=126) Η µεγαλύτερη τιµή γλυκόζης είναι 126

Stem width:        10
Each leaf:       1 case(s)

Stem-and-Leaf ∆ιάγραµµα Μίσχου-Φύλλου

Η αριστερή στήλη δηλώνει το σύνολο των φύλλων
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1.8 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Histogram-Ιστόγραµµα

Μπορούµε να δηµιουργήσουµε το ιστόγραµµα από το µενού Explore, από
το µενού Analyze/Descriptive/Frequencies αλλά και από το µενού των
Γραφηµάτων.
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1.9 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Histogram-Ιστόγραµµα

Αν θέλουµε να διατηρήσουµε τις ίδιες κλάσεις µε το διάγραµµα µίσχου
φύλλου, θα πρέπει να τροποποιήσουµε το ιστόγραµµα µέσω του Chart 
Editor.
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1.10 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Box Plot- ∆ιάγραµµα Πλαισίου Απολήξεων

Εµφανίζεται πάντα όταν κάνουµε χρήση του µενού Explore και επίσης
µπορεί να δηµιουργηθεί από το µενού των Γραφηµάτων.
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1.11 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Box Plot- ∆ιάγραµµα Πλαισίου Απολήξεων
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1.12 Ανάλυση ∆εδοµένων “Glucose”
Κατά φύλο

• Περιγραφικά Μέτρα Glucose κατά Φύλο
Analyze/Descriptive Statistics/Explore
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1.13 Ανάλυση ∆εδοµένων “Glucose”
Κατά φύλο

• Περιγραφικά Μέτρα Glucose κατά Φύλο

Descriptives

100,92 1,317
98,27

103,57

100,82
101,00
83,227

9,123
83

121
38
12

,196 ,343
-,430 ,674
99,15 1,527
96,09

102,22

99,20
99,00

121,270
11,012

70
126

56
13

-,107 ,330
,241 ,650

Mean
Lower Bound
Upper Bound

95% Confidence
Interval for Mean

5% Trimmed Mean
Median
Variance
Std. Deviation
Minimum
Maximum
Range
Interquartile Range
Skewness
Kurtosis
Mean

Lower Bound
Upper Bound

95% Confidence
Interval for Mean

5% Trimmed Mean
Median
Variance
Std. Deviation
Minimum
Maximum
Range
Interquartile Range
Skewness
Kurtosis

sex
female

male

glucose in blood mg%
Statistic Std. Error
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Ανάλυση ∆εδοµένων
Κατηγορικών Μεταβλητών

• Κατανοµή Συχνοτήτων
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2.1 Ανάλυση ∆εδοµένων “Sex”

• Ονοµαστική Μεταβλητή
Κατανοµή Συχνοτήτων

Analyze/Descriptive Statistics/Frequencies

sex

48 48,0 48,0 48,0
52 52,0 52,0 100,0

100 100,0 100,0

female
male
Total

Valid
Frequency Percent Valid Percent

Cumulative
Percent

Επικρατούσα
τιµή

Οι Αθροιστικές Συχνότητες ∆ΕΝ έχουν
νόηµα για κατηγορικές µεταβλητές
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2.2 Ανάλυση ∆εδοµένων Γραφικά
“Sex”
– Bar Chart

Τα γραφήµατα Bar Chart και Pie Chart µπορούµε να τα δηµιουργήσουµε
µέσω του µενού των Frequencies καθώς επίσης και από το µενού των
Γραφηµάτων.
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2.3 Ανάλυση ∆εδοµένων Γραφικά
“Sex”

– Bar Chart
Graph-
>Histogram

Μπορούµε να επιλέξουµε να εµφανίζεται η σχετική συχνότητα (%)
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2.4 Ανάλυση ∆εδοµένων Γραφικά
“Sex”
• Pie Chart

Graph->Chart
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2.5 Ανάλυση ∆εδοµένων Γραφικά
“Sex”

• Pie Chart
Graph->Chart
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3.1 Ανάλυση ∆εδοµένων “Status”
• ∆ιατάξιµη
Μεταβλητή
Κατανοµή
Συχνοτήτων

diabetes status

1 1,0 1,0 1,0
87 87,0 87,0 88,0
12 12,0 12,0 100,0

100 100,0 100,0

όχι διαβήτης
 οριακά
 διαβήτης
Total

Valid
Frequency Percent Valid Percent

Cumulative
Percent

88% των ατόµων έχουν τιµές γλυκόζης στο αίµα τους <112 mg%

Η Επικρατούσα Τιµή στη µεταβλητή status είναι Οριακά
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3.2 Ανάλυση ∆εδοµένων Γραφικά
“Status”
• Pie Chart

Graph->Chart
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3.3 Ανάλυση ∆εδοµένων Γραφικά
“Status”

•Bar Chart
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Επιλογή υποσυνόλου δεδοµένων
• Επιλογή υποσυνόλου δεδοµένων για
ανάλυση

Αν επιθυµούµε να εστιάσουµε την ανάλυσή µας σε µέρος των δεδοµένων, ας πούµε για
παράδειγµα στους άνδρες, δηλαδή προσδιορίζοντας If Condition is satisfied sex=1, µέσω του
µενού αυτού το SPSS δηµιουργεί µία µεταβλητή «φίλτρο» η οποία λαµβάνει την τιµή 1 µόνο
στους άνδρες. ∆ιατηρώντας την επιλογή αυτή µπορούµε να προχωρήσουµε σε ανάλυση των
συγκεκριµένων δεδοµένων. 
Αν θέλουµε να αναλύσουµε το σύνολο των δεδοµένων θα πρέπει να επιστρέψουµε στην ίδια
καρτέλα και να επιλέξουµε Select All Cases.
Αν είναι ενεργοποιηµένο κάποιο φίλτρο στο σύνολο των δεδοµένων µας τότε στην αριστερή
σκιασµένη περιοχή των δεδοµένων εµφανίζεται το σύµβολο (/) για κάθε περίπτωση που δεν
ικανοποιεί την επιλογή µας
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Ανάλυση ∆εδοµένων

Συµµετρική

Κατανοµή

∆εξιά Λοξή

Κατανοµή

Αριστερά Λοξή

Κατανοµή

•Κατανοµές

Οι δύο κατανοµές διαφέρουν στη συµµετρία. Η κατανοµή στα αριστερά είναι συµµετρική
ενώ η κατανοµή στα δεξιά ασύµµετρη /λοξή. 

Η συµµετρία προσδιορίζεται από τη ουρά µε το µεγαλύτερο µήκος. 
Αν η ουρά µε το µεγαλύτερο µήκος βρίσκεται προς το µέρος των µεγάλων αριθµών, τότε
η κατανοµή καλείται δεξιά ή θετική λοξή, ενώ στην αντίθετη περίπτωση καλείται
αριστερά ή αρνητικά λοξή.


